Excel Séance 5 - 2°™¢ partie

Theme numéro 10

Points essentiels abordés dans ce theme :

1. Mise a jour des données d’un tableau croisé dynamique.

2.  Personnalisation d’un tableau croisé dynamique.

3.  Création d’un graphique a partir d’un tableau croisé
dynamique

10.1. Mise a jour des données d’un
tableau croisé dynamique.

e |Lancez EXCEL.

e Ouvrez le classeur sauvegardé a la fin du theme 9.

« Selectionnez la feuille dans laquelle se trouve la liste a partir de
laguelle vous avez constitué votre tableau croise dynamique (en

principe, Feuill ou Sheetl). Attention, il faut étre sur la feuille feuil1 et pas sur
la feuille feuil4.

e Assurez-vous qu’au moins une cellule de la liste est sélectionnée.

e Activez la rubrique Formulaire ( Form )de la barre d’outils Acceés
rapide’.

e Cliquez sur le bouton Nouvelle.(|New)|)

e Introduisez trois ou quatre ventes pour un ou deux représentants
d’une nouvelle région, dont le nom soit situé par ordre alphabétique
entre IDF et PACA.

e Fermez la grille de saisie, en cliquant sur le bouton |[Fermer,

e Triez a nouveau vos donnees, par la technique détaillée lors du
theme 9.

o Sélectionnez la feuille dans laquelle se trouve le tableau croisé ( en
principe Feuil4).

L Si cette rubrique ne figure pas dans votre barre d’outils « accés rapide » reportez-vous au début du Théme N°8.
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e Activez la rubrigue Outils de tableau croisé dynamique=>
Analyse->Données>{Changer la source de données}->
Changer la source de donnees

e (Pivot Table Tools>Analysis=>Data->{Change Data
source}->Change Data source en anglais) pour prendre en compte
les nouvelles ventes (i.e. lignes) du tableau.

Ce n’est qu’aprés cette opération que les nouvelles données
apparaissent dans le tableau croisé.

Pour actualiser les données et totaux du tableau croisg,
e Activez la rubrique Outils de tableau croisé dynamique->
Analyse->» Données>{Actualiser}-> Actualiser

o (Pivot Table Tools>Analysis=>Data->{Refresh}->Refresh)
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10.2. Personnalisation du tableau croisé

Nous allons a présent créer des pages dans notre tableau.
e Faites glisser le bouton Région de la zone LIGNES a la zone
FILTRES

8 c D E E G H 1 K L M N 0 3 a R
1 |Region (Tous) = Liste de champs de tableau croisé dynamique ¥ X
2
3 Somme de Ventes Etiquettes de colonnes |~ f;pﬂfff‘?“e”hm””‘”c'”’edans'e
2 Etiquettes de lignes |~ anchois randade ¢ chips gruyére jambon olives saucisson comichons Fougasse Calissons | Total général .
5 =13 7825 12875 2000 22700 [¥|Région
3 uilh 7825 12875 20700 [~] Département
7 nis 2000 2000 [¥]Représentant
8 275 7800 8541 18500 15350 50191 [~ Produit
s Andrie 7800 541 18500 15350 50191 Flventes
10 | =84 15000 7875 23000 45875
11 Capelle 15000 15000
12 Hourd 787
13 Clissons 23000 23000
14 (=91 8500 7000 15200 30700
15 E 8500 7000 152 30700
16 592 12350 4500 16850 | Faites glisser les champs dans les zones voulues
17 Choblet 12350 12350 ci-dessous:
18 Perret 4500 4500 ' Filre du rapport #H Etiguettes de colonnes
18 =93 12800 | 1 12800
20 : n - o Région ~ Produit A
20 Delforge 128 12800
21 =94 6500 8000 14500
22 Espenant 6500 8000 14500
23 295 5000 14750 11800 31550
24 Fourgass 5000 14750 11800 31550 fE Etiquettes de lignes X valeurs
25 377 1300 2500 7700 5600 17700 "
- e Département * | | sommedeventes ¥

3 Colstart 1900 1900 .

Dunen 7700 7700 Representant

Newman 2500 5600 8100
25 =78 7800 7800
0 vers 7800 7880 | [ mifférer I mise 4 jour de la dispo. .
31 Total général 7825 29775 12800 23541 17500 68950 7875 52900 4500 2000 23000 250666

e Activez la rubriqgue Outils de tableau croisé dynamique=>
Analyse>Options du tableau croisé dynamique=> Options->
Afficher les pages de filtre du rapport... Une boite de dialogue
s’affiche et vous propose « region », validez par OK,

Une page (ou feuille) est alors créée par région. Ici une feuille est
dédiée a la region IDF, une a la région PACA et une derniére a la
région pour laquelle vous venez d’ajouter des ventes (cf. paragraphe
10.1).

Si vous choisissez une seule région (par exemple IDF), les autres
disparaissent de I’affichage.
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A B C D E F G

Région _|IDF Ej
Somme de Ventes Etiquettes de colonnes |-
Etiquettes de lignes |- brandad bert chips cornich gruyére jamb
=75 7800 8541 18500
Andrieu 7800 8541 18500
277 1900 2500 7700
Colstart 1900
Dunon 7700
Newman 2500
=78
Versil
=91 8500 7000 15200
Bernier 8500 7000 15200
=92 4500
Choblet
Perret 4500
=93 12800
Delforge 12800
=94 6500 8000
Espenant 6500 8000
=95 5000 14500
Fourgassie 5000 14500
Total général 1900 12800 23541 4500 17500 68700
M [ tablnitial | IDF PACA ~Feuil? ~FeuiB Feui? tabTrié  ~Feull Feuis /%3 [«

saucisson Total général

15350
15350
5600

5600
7800
7800

12350
12350

11800
11800
52900

50191
50191
17700
1900
7700
8100
7800
7800
30700
30700
16850
12350
4500
12800
12800
14500
14500
31300
31300
181841

x

" Liste de champs de tableau croisé dynamique -

Choisissez les champs & indure dans ke rapport : &~
7| Régio 7|
7| Département

Représentant
Produil
7|Ventes

Faites glisser les champs dans les zones voulues ci-dessaus:

“F Filtre durapport 1 Etiquettss de colonnes
Région = || | produit

] Etiquettes delignes I Valeurs
Département ~ | | somme de ventes
Représentant

| 7] pifférer la mise  jour de Is disposition

Il est également possible de faire afficher plusieurs fois la méme
donnée dans la zone VALEURS, en utilisant des fonctions de
récapitulation différentes.
e Activez la rubriqgue Outils de tableau croisé dynamique=>
Analyse->Afficher/Masquer->Liste des champs, la boite de
dialogue «liste des champs de tableau croisé dynamique »

apparait.

Faites glisser le bouton Ventes une seconde fois vers la zone

VALEURS. Des lignes intitulées Somme de Ventes2 apparaissent

dans le tableau. Faites un clic droit sur I'un des textes
Somme Ventes2, puis activez la rubrique « Paramétres des champs
de valeurs » du menu contextuel qui s’ouvre alors. VVous voyez
s’afficher la boite de modification d’un champ de tableau croisé.

Choisissez synthese par moyenne. Le nom du bouton devient

Moyenne de Ventes?2,

Modifiez le nom en Moyenne de Ventes

Madame Véronique HEIWY
L’usage de cette brochure est réservé exclusivement aux travaux dirigés de I’Université PARIS 1, UFR
Gestion-Sorbonne, L2



Excel Séance 5 - 2°™¢ partie

Champs de tableau croisé dynamique ~ %
Choisissez les champs a inclure dans le rapport : A
Rechercher jel
Région

Département

Représentant

Produit
Ventes

Plus de tableaux...

Faites glisser les champs dans les zones voulues ci-dessous:

Filtres Colonnes
Région v Produit A
2 Valeurs il
Lignes > Valeurs
Département « | ~| Somme de Ventes v | a
Représentant » |« Moyenne de Ventes v -

Différer la mise a jour de la disposition

e Validez par [Entree] ou en cliquant sur le bouton OK.

Vous voyez apparaitre dans votre tableau les moyennes demandées.

Pour améliorer la lisibilité, il est possible de retravailler | ‘alignement,
les bordures, le centrage, la couleur des polices des données affichées
dans les cellules (en utilisant les possibilités de | 'onglet « Accueil » du
ruban.

Il est également possible de modifier «entéte de colonne» en
« produits » et «entéte de ligne » en « département/représentant »
mais attention, il n’est pas possible de supprimer ces noms, seulement
de les modifier.

1 Région I0F ¥ Champs de tableau croisé dynamique ~ %
produ - Choisissez les champs & inclure dans le rapport
1 ! i § | Total Somme [
1, ! M e ¥
membert hips [gruyare jambon saucisso doventes . Moyenne
! ! ! ! o T ventes :
departement/ | S9™Me  Moyenn |Somme Moyenn | Somme Moyenn iSomme Moyenn | Somme Moyenn 1| Région
"’m. A de  ede | de  ede | de ede | de  ede | de ade [7] Département
s | " “| Ventes Ventes | Ventes Ventes | Vantes Ventes |Ventes Ventes | Ventes Ventes Rape
6 =78 7800 7800 | 8541 8541 | 18500 18500 | 15350 15350 50191 12547, 75 c -
7 Andrieu 7800 7800 | 8541 8541 | 18500 18500 | 15350 15350 191 47,75 Y| Produit
8 =91 | 8500 8500 | 7000 7000 15200 15200 | ! 30700 10233, ,33333 [V] ventes
9 Bernie i 8500 8500 | 7000 15200 1 i
10 =92 i i | 12350 12350 12350 12350 Plus de tableau
1 Choblet ! ! 112350 12350
i i
12 =93 12800 12800 ; I hamps dan: lue !
13 Dell i 1 | 12800 1280 0
14 =94 | 6500 6500 | 8000 8000 i 14500 7250 Filtres e
15 Espenant ! 6500 6500 ! 8000 1 0
i i i
16 =95 5000 5000 | ! ! 14500 14500 | 11800 11800 31300 10433, 33333 duit
17 Fourgassie | 5000 5000 | i 14500 14500 | 11800 11800 10433,33333
18 Totalgénéral | 12800 6400 | 23541 7847 | 15000 7500 | 61000 15250 | 39500 131667 | 151841  10845,78571
19
20
21
22
23
4 v
£ r = Jifférer la mise & jour de la dispositior
IDF | PACA Nouvelle-Aquitaine Feuild | Feuill ' ‘ »
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Il est également possible de déplacer des colonnes, ou des groupes de
lignes. Nous allons, par exemple, regrouper les fromages, en
permutant les colonnes camembert et chips.

Sélectionnez I’intitulé camembert.

Cliquer droit

Choisir la rubrique « déplacer »

Choisir la rubrique « déplacer camembert a la fin »
Sélectionnez 1’intitulé gruyere.

Cliquer droit

Choisir la rubrique « déplacer »

Choisir la rubrique « déplacer gruyere a la fin »

Les deux colonnes camembert et gruyere sont voisines
maintenant.

serait de méme possible de déplacer un département ou un

représentant par rapport aux autres.
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10.3. Création d’un graphique a partir
d’un tableau croisé

Nous allons créer un graphique en « camembert » ( ou « secteur »
« pie » en anglais) a partir des ventes par article, cumulées en derniére
ligne.

Débarrassez-vous des moyennes des ventes :

Activez la rubrique Outils de tableau croisé dynamique->
Analyse->» Afficher/Masquer-> Liste des champs, la boite de
dialogue « liste des champs de tableau croisé dynamique »
apparait.

Dans la zone « Valeurs », sélectionnez « Moyenne de Ventes »
Cliquez dessus, un menu contextuel apparait.
Choisissez « Supprimer le champ ».

Les moyennes des ventes ont a présent disparu.

Sélectionnez les ventes cumulées par produit de la derniére ligne du
tableau croisé.

Activez la rubrique Insertion>Graphiques. Choisir I’icone
correspondant aux « Histogrammes en baton » et choisissez la
deuxiéme icone dans Histogramme 2D.

(Insert->Charts en anglais)

Vous voyez apparaitre un graphique a barres empilées, agréementé du
volet «filtre de graphique croisé dynamique » contenant des
rubriques qui proviennent du tableau croisé.
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(@

(o]

Région ¥
Somme de Ventas

60000

50000

40000

c) 30000

20000
10000 I I

0

Produit hd
W gruyére
camembert )

saucisson

. l l M jambon
u chips
Andrieu = Bernier = Choblet Delforge Espenant Fourgassie
75 91 92 93 94 95
Département ~ Représentant - + -
O 0 0]
N »

Faites disparaitre les boutons

Séance 5 - 2°™¢ partie

Champs de graphique cro... ~ X

Choisissez les champs & inclure dans le rapport : &+~
Rechercher jol
Région h

Département
Représentant
Produit
Ventes

Faites glisser les champs dans les zones voulues
ci-dessous:

Y Filtres Il Legende (série)

Région v Produit b
= Axe (catégories) % Valeurs

Département ~ = | Somme de Ventes b

n - F— -

Différer la mise & jour de la dispositi...

Département et

des

Représentant

« champs Axe (Abscisses) » dans le graphique.

e Pour cela,

e selectionnez tour a tour chaque rubrique dans le graphique

e supprimez-les en choisissant la rubrique « supprimer le champ » du
menu contextuel affiché aprés clic-droit

0 O 0]
Région LY
Somme de Ventes
160000
140000 [ o
120000 i
ruyére
(D 100000 ery
20000 camembert
60000 DO BEsaucisson
40000 Hjambon
20000 wch
chips
0 P!
Total
O O O

Champs de graphique cro.. ~ %

Choisissez les champs & inclure dans le rapport : -
Rechercher el
Région h

O Département
O Représentant
Produit
Ventes

Faites glisser les champs dans les zones voulues
ci-dessous:

Y Filtres Il Légende (série)
Région v Produit M
= Axe (catégories) 2 Valeurs
Somme de Ventes -

e Pour réafficher la liste des champs, activez la rubrique Outils de
graphique croisé dynamique—> Analyse—>L.iste des champs. La
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boite de dialogue «Liste de champs de tableau croisé
dynamique » apparait.

e \ous pouvez aussi «insérer des segments » en activant cette
rubrique dans Outils de graphique croisé dynamique=>
Analyse->Filtrer-=>insérer un segment.

e Si vous choisissez de changer de type de graphique pour avoir un
histogramme cumulé, vous obtiendrez ceci :

= exe-x8-themed s y ‘ = B =
Accueil Insertion Mise en page Formules Données Révision Affichage Développeur Compléments IMP Acrobat Equipe Création Disposition Mise en forme Analyse ca@o@ R
. I
=] 7] (5
=] = F
Insérer un Effa Liste des| Boutol
gment - champs |de champ
hamp actif Données Afficher/Masq
Graphique 1 5
A B c D E F G H 1 ] K L M = | Liste de champs de tableau croisé dynamique v x
T =
2 Choisissez les champs & indlure dans le rapport :
3 Etiquettes de colonnes | ~ [“IRégion
4 anchois brandade camembert chips gruyére jambon olives saucisson Total général [Ioépartement
5 Somme de Ventes 7825 27875 12800 23541 15000 61000 7875 39500 195416 [EJReprésentant
/| Produit
5 e o =) u
[/]Ventes
7 Somme de Vente:
z [CJrégion
100% — [|Département
: []Rep: tant
10 80% — [CProduit
1
80% - [Cvente:
12 Produit
13 70% ————————— " saucisson
14 .
T co% | olives
05 jambo =
50% ——————————————— I N
17 B gruyén
8 40% u chips Faites glisser les champs dans les zones voulues d-dessous:
19 B camembert F Filtre du rapport FH Champs Légende (Série)
20 30% - —
brandade Brodl
2 20% -
= = anchois
23 1o f— I
2
= PopEmm———
Total ] Champs Axe (Absdisses) I Valeurs
2% o
28
29
30
31
32 | [7] Différer la mise  jour de la disposition
Cl v | _tabInitial “Feuil | Feuil2 tabTrié ~Feuid %2 nEN! ] (0}

Légende (Serie) » a la zone « Champs Axe (Abscisses) » dans la
boite de dialogue «Liste de champs de tableau croisé
dynamique »Vous obtenez le graphique suivant :
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excel2019-Theme10-3.xlsx - Excel

Révision  Affichage  Développeur

o = _— i | .

Ajouter un élément Disposition Modifier les . — = -_— . . Intervertir  Sélectionner Modifier le type Déplacer le

graphique ~ rapide~  couleurs ~ lignefcolonne des données  de graphique  graphique

Dispositions du graphique Styles du graphique Données Type Emplacement -~
Graphique 1 - bz v

A 8 c D 3 F G H 1 J K L M i
1 Région o x Champs de graphique cro.. = %
2
3 departement/representant - Somme de Ventas Choisissez les champs & inclure dans le rapport: | & ~
4 chips ; 23541
5 jambon i 61000 jel
6 saucissan i 39500
7 |camembert 1 12800 T
8 guyire | 15000
9 Total général 151841
10
1
12
13
14
15
16
17
18
19
20 T Filtres 1 Légende (série)
21
Région
22 &l
23
24 = Aue (catégories) Z Valeurs
25
26 Produit ' Somme de Ventes
27
%
IDF | PACA | Nouvelle-Aquitaine | Feuild | Feuill ¥ Différer la mise & jour de la dispositi..

U= B m [ - 1 ] + 80%

e Effacez la Iégende Total en choisissant Supprimer ( Delete ) dans
le menu contextuel obtenu grace a un clic droit sur ladite Iégende.

o Effacez le titre Total aussi.
Le graphique apparait alors comme suit:

Région ¥
Somme de Ventes
Total
80000
Os0000
40000
- .
0 | I
chips jambon saucisson  camembert gruyére
Produit -
[ M

e Activez la rubrigue Outils de graphique croisé
dynamique->Creéation->Type->Modifier le type de graphique,
la boite de dialogue ci-dessous apparait :
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Madifier le type de graphique ? X i

{Tous les graphiques |

= v i R 8 s a2 03 40

Histogramme

Courbe Histogramme empilé
Secteurs

Barres

Aires

XY (nuage de points)
Carte

T

EEHEBEEEE

Boursier

Total
m
m
m
m
m ot
o I
o
m B
<hips ambon  swcmon  Gmembert gl

Surface
Radar

Compartimentage

Rayons de soleil
Histogramme
Zone et valeur
Cascade

Entonnoir

FIEEFOEXDESESMOTE

Graphique combiné

e Choisissez un diagramme en « Secteurs » (Pie en anglais). Un
« camembert » apparait :

o O 0
Région T
Somme de Ventes
Total
o) Produit (o]
m chips
M jambon
saucisson
camembert
[ J “ s Yy

e Choisissez la mise en forme finale de votre graphique en
sélectionnant celle qui vous convient dans la liste proposée dans la
rubrique Outils de graphique croisé dynamique->Création->
Dispositions du graphique->»Disposition rapide
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H 9- v excel2019-Theme10-3.xsx - Excel
Fichier Accueil Insertion Mise en page Formules Données Révision Affichage Développeur lyse réation oulez faire
. p— —
= = = e
[ 3 L », 2 » - mIE: Il -

Ajouter un élément Disposition Maodifier les ‘ < - Intervertir  Sélectionner Modifier le type Déplacer le
graphique ©  rapide  couleurs * ligne/colonne des données  de graphique  graphique
Dispositions du graphique Styles du graphique Données Type Emplacemen t

Graphique 1 f

A 8 c D 3 £ [5 H | J K L M oo .

1 Région IoF x Champs de graphique cro.. =

2

3 departement/representant - Somme de Ventes Chaisissez les champs & inclure dans le rapport :

4 chips 23541

61000 I echercher
39500 ! o] O ]
12800 Régon Y +
15000 Somma da Ventes
9 Total général 151841 r
10 Total -

IDF | PACA | Nouvelle-Aquitaine | Feuild | Feuill ) . y Différer la mise a jour de la dispositi...

() W O & B @ | W

Votre graphique est terminé. VVous auriez tout aussi bien pu y montrer
les ventes par représentant, tous produits confondus, en conservant
dans la zone catégories le bouton représentant.

Si vous avez la curiosité de regarder le TCD , vous aurez la surprise
de constater que celui-ci s’est fortement simplifié, comme vous
pouvez le voir sur la figure ci-dessus, dans sa partie gauche.
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